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	 Resultado da soma de fragmentos de memória, história e imagens, os quais permearam 
toda minha formação individual, e, transitando paralelamente às minhas vivências durante sua 
produção, P, viabiliza um diálogo direto entre o leitor e a atmosfera perceptiva e criativa do autor.
	 O livro objeto ou livro de artista, foi elaborado ao longo de dois anos, tendo como ponto de 
partida o acervo fotográfico familiar em posse de: Jacira Valverde Carvalho (mãe de minha mãe).
	 Proposto como livro físico, o leitor deve alocar as imagens Policromáticas nos devidos espa-
ços, todavia, não existe uma orientação precisa para isto, deve-se atribuir ao texto uma imagem. 
Este exemplar que segue, é a versão digital, todas as imagens já estão organizadas e distribuídas 
em seu devido lugar tanto textual quanto de ordem.
	 P é um Trabalho de Conclusão de Curso em Gravura, afim de expressar o domínio técnico do 
autor, o mesmo manufaturou inteiramente todos os exemplares. Possuindo uma tiragem de cinco 
cópias totalmente impressas à mão na técnica de serigrafia monocromática (texto), contando com 
dez imagens 140x105 mm, impressas à mão na técnica de serigrafia policromica. Além disso, resi-
dualmente foram impressas: 200 policromias teste (além da tiragem definitiva) e 3 livros (além da 
tiragem definitiva).

	 As páginas que seguem, foram re diagramadas a partir do ar-
quivo original para impressão do fotolito, as imagens em cores, são 
reproduções digitais das imagens que compõem a tiragem 1/5 dos 
livros físicos.

“... o próprio destino é como um tecido maravilhoso, amplo, 
no qual cada fio é conduzido por dedos de uma delicadeza 
infinita, posto ao lado de outro fio, ligado a centenas de ou-
tros que o sustentam.”

RILKE, RAINER MARIA, 2007, p. 34, Cartas a um Jovem Poeta
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“Mas nunca há dignidade sem fraqueza,
nunca há pensamento sem imagem.”

(Sartre, A Imaginação, p. 32-3)
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	 Parte dos últimos sete anos, dediquei ao estudo da imagem, em todas as 	
linguagens que estavam ao meu alcance. A produção gráfica é parte dos seguimentos 
de meus trabalho, acredito eu, que concluir todo o processo com este livro, é uma forma 
de amarrar todos os aprendizados em um só.
	 Este trabalho, é fruto de um processo de reconstrução da memória de meus avós, 
e transmissão das lembranças deles para mim, concretizando um livro, que, assim como 
tantos outros, só existirá enquanto houver necessidade de ser folheado, do contrário, 
deixará de existir. Este objeto, busca transcrever o que motiva  minha mente a produzir 
uma imagem, desconstruir um passado intenso (em que eu não existo) e propor ao leitor 
que encontre o lugar destas realidades.
	 Toda a construção por de trás deste, surge de um profundo desconforto, de 
um complexo “deslugar” e de uma necessidade em descobrir o novo, energias que 	
incentivaram o meu estudo e pesquisa em  serigrafia e policromia.
	 Por fim, lê-se a seguir o resultado de um pensamento, uma ideia, uma imagem.	
O objeto e seus desdobramentos aqui elaborados, buscam proporcionar as mais 	
diversas interpretações, também possuindo uma infinidade de significados poeticamente 	
secretos.

	 Lembrança seca tenho eu, sobre quando  
comecei este livro. Revirando caixas rechadas 
de vivências antigas, imagens de um contexto 
político, equivalente ao que vivo agora. 
	 É nítido, a ditadura não acabou.
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	 A criatividade é como uma janela pequena, e a mente é como um infinito quarto 
escuro, onde a janela esta situada no centro de uma das quatro paredes. Forrando este 
quarto está o nosso consciente, ele funciona como um filtro desta janela, e, assim sendo, 
faz juízo de tudo aquilo que irá ocupar o quarto, que logo poderá se materializar, extra-
polando o ambiente criativo e se tornando algo físico/real. Gosto de problematizar as 
demais fronteiras e formas de se criar algo através desta metáfora do espaço imaginário 
(vamos chamar de quarto criativo)
	 O indivíduo, que tem a criatividade presente em seu cotidiano (pensamos aqui 
em artes que envolvem a imagem, o corpo, a escrita e a musicalidade), habita um limiar, 
entre a produção e a criatividade. O “quarto criativo” seria um espaço de acúmulo, recep-
tor ativo a todo momento. Sua janela, livre de filtros, permite que algo novo o ocupe com 
frequência, independente da circunstância. Ainda que aconteça uma ociosidade produ-
tiva (no que diz respeito ao plano físico/real), a mente sobrepõe ideias a todo instante, 
algumas se tornam realidade, outras não.
	 Aquele que, ao longo de sua formação, não mantém a janela do quarto criativo 
aberta, possui dificuldades em compreender tarefas que demandem mais criatividade 
(ainda assim, podendo direcionar sua capacidade criativa para outro meio que não artís-
tico). Dessa forma, ao se deparar com algo complexo, e que exija uma perícia ou conheci-
mento para que seja produzido ou desconstruído (como por exemplo: desenho, maqui-
nário, equação etc.), o observador pode determinar que esta perícia ou conhecimento se 
trata de um dom, algo que foge ao seu domínio. Se introduzirmos aqui o pensamento do 
quarto criativo proposto anteriormente, é compreensível dizer que a mente possui di-
versas janelas e quartos, responsáveis em armazenar ideias e conhecimentos diferentes. 
Todavia, ao longo de nossa formação (individual e intelectual), escolhemos quais janelas 
permanecerão abertas e quais janelas serão fechadas, e além disso, há aquelas que não 
conseguimos abrir. No geral e de forma romântica, é compreensível afirmar que, aquele 
que cria, infelizmente, não terá tempo em vida de reproduzir tudo o que passou por sua 
janela criativa.
	 Então quais escolhas fazer? Quais imagens criar?! O que deixar, e o que levar con-
sigo?! Perguntas que me atormentam a todo momento. Acredito que a fotografia (assim 
como esboços, anotações, etc) seja um importante mecanismo para a captura e registro 
da memória. Dessa forma, fotografar (esboçar, anotar, etc.) algo, é uma ferramenta para 
dinamizar o processo de produção imagética.
	 Ao mesmo tempo, essa captura possui um invólucro de memórias e vivências 
relacionadas à mente que as registrou, idealizou ou compôs. Pensemos nesses registros 

Polaroide

Tenho comigo desejo antigo de ter uma polaroide.
Minha infância
foi a primeira vez que vi uma foto surgir, de lugar algum.
Tive medo, para mim, era bruxaria.
Mas tive uma satisfação, estranha.
Polaroide é um fetiche,
a criatividade também.
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como sendo um banco de imagens autorais, reais, revelados em papel fotográfico ou 
não, e possuidores de um significado próprio desconhecido para aquele que não parti-
cipou da captura do momento (aqui vou trabalhar especificamente com registros foto-
gráficos). Podendo pertencer a qualquer um, contanto que seja um registro fotográfico, 
e que a partir dele possa ser viabilizado um experimento imagético. Então, possuindo 
esse acervo, resolvemos aqui a problemática de quais escolhas fazer, pois se compre-
ende que: com um acervo referencial, temos um facilitador para o ponto de partida do 
pensamento da imagem.
	 O processo criativo de uma imagem pode seguir diversos caminhos, uma vez que 
cada indivíduo possui metodologia autoral. Pensando em meu processo criativo posso 
dividi-lo em três momentos: concepção da imagem, técnica a ser utilizada e produção. 
Tendo um acervo referencial, dou inicio ao processo de concepção da imagem (apro-
prio-me desse referencial como ponto de partida). Aqui resolvo a segunda questão, de 
quais imagens criar. Dessa forma, assumo quais imagens  expurgo do meu quarto criati-
vo, permitindo-as sua real existência. Mas não posso afirmar que exista uma consciência 
plena e individual sobre quais imagens produzir e quais não, pois acima de tudo impera 
uma questão sensível, sensorial e educacional.
	 O contato e o interesse pelas artes, pela produção artística, pode acontecer em pa-
ralelo ao meio em que o indivíduo desenvolve seu intelecto, logo, se este tem um vetor 
(família, escola etc) que instiga seu contato com imagens, por exemplo, seu desenvolvi-
mento imagético será progressivo, fechando ou abrindo outras janelas em detrimento 
deste conhecimento imagético. Acredito que esta é a melhor forma de desconstruir o 
mito do dom. É importante nos situarmos como indivíduos biologicamente semelhan-
tes, capazes de feitos similares, e por meio da individualidade de cada um descrevemos 
perícias iguais, porém, com um domínio e proposta distintos.
	 Logo, todos sabemos desenhar, entretanto uns possuem mais domínio que ou-
tros. Aplicar este raciocínio ao meu exercício da imagem é impreterivelmente importan-
te. Existe em mim uma necessidade de fazer, enquanto imagem, aquilo que seja plural, 
horizontal, que intente reabrir as janelas do imaginário do observador. Pensando no con-
temporâneo, não acredito que a arte deva dialogar apenas com aqueles que possuam 
aptidões acerca da imagem, menos ainda para os que ao longo de seu desenvolvimento 
intelectual tiveram acesso a uma educação bem elaborada, que os possibilita compre-
ender tudo ou quase tudo, questionar, administrar e até possuir de forma restritiva o 
conhecimento.
	 A arte deve dialogar principalmente com aquele que não possui mais esperança, 
que encontra em sua sombra uma desagradável memória do estar no presente. Deve 
abrir a fronteira deste indivíduo, fazê-lo perceber que sua insignificância para com o uni-
verso é apenas uma metáfora, e que o que deve imperar sobre esta metáfora é o seu 
consciente, sua arma mais poderosa contra a solidão. A arte deve ter o poder transfor-
mador, de expandir a sua percepção, de acrescentar em seu intelecto algo novo, instigar, 
movimentar, e principalmente fazer sentir, muito mais do que “fazer sentido”.
	 Por fim, a imagem só existe quando há aquele que a observa e a absorve; para 
aquele que cria, ela é parte do dele, é como um organismo vivo, um filho. Possui nome, 
ou não, possui dimensões, ou não, possui personalidade, ou não, possui vida, ou não.
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”(...) o autor alimenta o livro quer dizer 
que existe antes dele, pensa, sofre, vive 
com ele;(...) 

(Barthes, A Morte do Autor, p.63)”

“Evocar uma lembrança é tornar presente 
uma imagem passada, mas a imagem 
armazenada, sem o que não se compre-
enderia, a propósito de um rosto do qual 
tenho uma série de lembranças distintas 
que correspondem à multiplicidade das 
percepções, de que maneira evoco uma 
imagem única, que pode inclusive não 
coincidir exatamente com nenhuma das 
lembranças registradas.“

(Sartre, A Imaginação, p. 49)

	 Enfim, um paradoxo, que pode ser quebrado mediante a significância que o agen-
te observador atribui à imagem, fugindo ao controle daquele que a produziu (“O que 
deixar, e o que levar consigo?!”), impera aqui como uma questão ativa a todo instante.

	 A fim de compreender melhor estas e outras questões em torno da Imagem, pro-
duzi um experimento imagético com dois grupos distintos, minha família materna e a 
paterna. Imprimi a mesma imagem em policromia serigráfica, e presenteei a todos com 
uma cópia. Não possuindo título, orientação e qualquer outra maneira que viabilizasse a 
compreensão da gravura, e aliado a isso a técnica de impressão profusa: desconstruía em 
muito a imagem, havia ali uma perda da representação fidedigna e uma abertura para 
abstração.
	 Tive então como resultado que na família A, em sua maioria elitizada, não houve 
debate acerca do que se tratava a imagem, questionamentos ou abstrações. Ao con-
trário, na família B, menos elitizada, com diálogo horizontal e com uma abertura maior 
ao debate, foram levantadas diversas questões e interpretações, surgindo grupos com 
interpretações distintas da gravura. Era um experimento sem pretensões, a serigrafia era 
como uma simples foto de polaroide, mas que direcionou minha atenção para o estudo 
da policromia e suas possibilidades.
(Gravura)
	 Todos temos uma história paralela à nossa, desconhecida pessoalmente, não vi-
vida, porém conhecida e perpetuada através de registros que vêm do passado para o 
presente, acompanhados de memórias que chegam até nós por entre conversas com 
parentes de outrora. Há muito tenho desenvolvido esse interesse pelas imagens que 
abrangem a história da minha origem parental. Percebo esse momento de observar an-
tigos registros fotográficos como sendo o outono, um período de mudanças, cores, ares 
e sabores carregados de memória. Melancólico, o outono possui um vento, um som e 
uma cor característicos, causando em mim uma mudança interna, uma necessidade de 
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lembrar, de compreender, registrar e reencontrar. Revirando antigos acervos imagéticos, 
redescobri lembranças e narrativas das quais não presenciei, como quando chegamos a 
uma cidade em meio ao outono, e a vegetação se comportava de maneira tal, que pare-
cia nos contar uma história, do antes de nós chegarmos ali.
	 Comecei então a selecionar essas imagens (fotografias) que contavam, para mim, 
a história de um outono desconhecido. Imagens antigas em uma caixa de sapato, cente-
nas. Entre elas existe esta que assume uma característica particular, uma foto que creio 
jamais ver novamente. Esse fato causa um conflito interno entre uma certeza e uma 
memória embaçada, já não sei de fato se aquela imagem especifica existiu ou não, ela 
ocupa um espaço considerável em meu quarto criativo, possuo planos infindáveis para 
ela, porém, não consigo esboçá-la, não a encontro fisicamente, apenas mentalmente, 
em ideia, um fator, apenas, uma incógnita. 

“(...)A imagem é um estado presente e só 
pode participar do passado pela lembran-
ça da qual saiu.”

 (Sartre, A Imaginação, p. 49)

 	 Há um processo de perda em cada indivíduo, e, por isso, registrar algo é a forma 
mais orgânica de perpetuar um conhecimento, uma história. Dessa forma, (re)-retratar 
uma imagem é tomar para si uma memória, intervir nesta e torná-la sua. Sugiro então 
esse exercício, para mim (e para você, por que não?), a fim de compreender melhor os 
indivíduos da minha família, do meu círculo parental, e que, em algum momento, novos 
questionamentos flertem com minha janela criativa. Esse exercício de observar imagens 
é, ao mesmo tempo, uma investigação e um constante lidar com a plasticidade da me-
mória.



12

“Mas é uma universalidade potencial que 
se conclui do fato de a palavra poder ser 
acompanhada de imagens muito diferen-
tes. Através dessas imagens particulares, 
estende-se uma espécie de regra que di-
rige sua escolha. Mas não há “consciência 
da regra “, no sentido em que a entende-
rá mais tarde de Würzburg. A regra - que 
é o conceito - nunca se dá se não numa 
imagem particular e como simples pos-
sibilidade substituir esta por uma outra 
imagem equivalente”

 (Sartre, A Imaginação, p. 34)

 	 Tomei tempo para isso, sentei ao lado de minha avó, conversamos por horas so-
bre cada uma das imagens: da grande maioria, já não possuía lembranças ou não eram 
de sua autoria. Existe aqui um gozo maior para aquele que vasculha lembranças (eu), 
com intenção de encontrar o desconhecido, do que significam os registros fotográficos 
para aquele que traduz (minha avó) ou ao observador extasiado (eu).

	 “Essa sou no meu jardim, é, no meu jardim, esse é o Alcyr, e essa você conhece?!... 
Essa é a Nádia… Como meu jardim era bonito, nossa… Eu até que gostaria, mas, já estou 
velha, e exige muito da gente fisicamente, não dou conta não. Olha essa foto aqui, aqui 
dá pra ver melhor.”
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	 Parte de minhas origens vêm do interior de Minas Gerais, mudaram-se para Belo 
Horizonte por motivos políticos. A sua chegada à capital possibilitou minha existência, 
uma vez que, caso contrario, meus pais não teriam se conhecido. Todo esse processo de 
mudança foi registrado em fotos antigas e conversas entre eu e meus parentes. Meu avô 
possuía esse hábito de registrar todo e qualquer acontecimento, e antes de terem uma 
câmera, por algum motivo desconhecido, sempre havia um fotógrafo por perto que fa-
zia o registro e revelava a foto instantaneamente, então a grande maioria das imagens 
que descubro são de autoria desconhecida, é como ter em mãos a memória quântica¹. 
Existe, aqui, uma necessidade de perpetuar a história que se constrói, todos esses regis-
tros contam como as coisas seguiram no passado até os dias de hoje, expõe a dificulda-
de, as mudanças e a esperança de uma forma honesta e direta.
	 Uma pintura, xilogravura, desenho ou escultura eram formas usuais de perpetuar 
a memória de um indivíduo, em função de transmiti-la adiante. A fotografia possui fun-
ção semelhante, além de ser, para o individuo em ascensão social (aproximadamente 
1940 à1989, período por onde caminham as imagens), uma forma de contar suas vi-
vências, mesmo que para si mesmo. Surgem então todos os tipos de registros, e a sua 
quantidade diminui à medida que as dificuldades vão se tornando apenas obstáculos. 
Aparentemente, nas caixas de sapato, invólucros das memórias de meus avós, fica evi-
dente que, com o passar dos anos, a memória imagética foi dando mais espaço para a 
memória pura (ou lembrança), e sem veículo de transmissão.
	 Possuo então esse apanhado de imagens das quais não há um sentido lógico para 
mim, aquelas lembranças não saíram de mim, porém (por meio de conversas com seus 
proprietários) eu sei o que elas são, o que elas representam. Além disso, posso alterá-las, 
de maneira que, agora, exista uma memória e um significado onde eu possa inserir as 
minhas lembranças. O fruto deste exercício imagético tem sido sofrido (é perceptível 
que muito foi omitido e muito está sendo perdido): assistir ao fato de que a memória de 
meus antecessores tem se esvaído e que, mesmo possuindo um artefato/atalho para o 
ativamento destas memórias, ainda assim, elas se mostram turvas e ocres, é em muitos 
momentos pontiagudo, seco e desgostoso o silencio que segue após a pergunta: “E esta 
foto, é a onde?! Quem são essas pessoas?!”. Os olhos correm todos os cantos da imagem, 
as sinapses acontecem, mas elas não produzem mais palavras, talvez apenas memórias 
sem sentido, memórias que eu jamais serei capaz de visualizar, segue então após o silên-
cio, apenas uma resposta negativa.

“A imaginação, portanto, muito antes de 
Malebranche, é suspeita de ser “a amante 
do erro e da falsidade”. A imagem pode 
se desenovelar dentro de uma descrição 
infinita e uma contemplação inesgotá-
vel. Incapaz de permanecer bloqueada 
no enunciado claro de um silogismo, ela 
propõe uma “realidade velada” enquan-
to a lógica aristotélica exige “claridade e 
diferença” ”

(Durand-Gilbert, O Imaginário, p.10)
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	 A frustração de não encontrar a imagem que procuro para realizar meu trabalho 
em policromia aumenta cada vez mais (estou ficando louco?! Essa memória se perdeu?!). 
Algumas pessoas próximas dizem lembrar da foto, mas não sabem de seu paradeiro (se 
ao menos tivéssemos o negativo…), as fotos acabam se tornando fotos de polaroide (o 
que não são). Uma polaroide possui um cartucho de 10 poses, revela as fotos instan-
taneamente, e não produz um negativo. Dessa maneira, jamais haverá uma forma de 
reimprimir ou ampliar aquela foto por meios analógicos, apenas digitais.

	 “ A perna treme, a garganta comprime, o peito dói,  é difícil respirar. 
	 Ele tinha capa, podia ser um super herói, atrás do maquinário ele vio o tempo 
passar. Oconheço apenas  por esta foto, ainda assim, me preocupo com ele e com tantos 
outros que não tiveram opção.
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“A energia pura, vem de por entre lugares, inconcebíveis ao ser humano”

O imaginário é uma ferramenta interessante, ele funciona de maneira diferente em cada 
indivíduo, demanda uma série de fatores para que aconteça uma interpretação coerente 
de uma imagem profusa. Ainda assim, esta interpretação de algo abstrato ou profuso 
será em sua maioria particular, fazendo sentido apenas para aquele que constrói a in-
terpretação a partir de seu conhecimento, percepção e sensibilidade, e, diferente será, 
para quaisquer outro indivíduo que observar a mesma imagem. Consigo elaborar este 
pensamento a partir do experimento que reproduzi com meus familiares. Tenho então 
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que, a partir deste, elaborei esta série de imagens que condizem com as memórias deles, 
alterando todas as imagens e tornando-as minhas, minhas memórias. Misturadas a estas 
releituras, fotografias de minha autoria, que dialogam com o mesmo período histórico 
em que minhas raízes se tornaram árvore.

	 A pesquisa em arte é, para mim, um eterno fazer, um eterno construir. Descobre-
-se a todo momento uma nova maneira de expressar aquilo que se pensa, de elaborar 
um conceito. A cada primavera, encontro um novo motivo para repensar minhas conclu-
sões, e ao todo, já se foram 27 primaveras até hoje. A necessidade de aprender, desco-
brir outras linguagens, aproximou-me da Serigrafia e de suas grandezas, uma técnica de 
gravura complexa, porém mais dinâmica e de uma plasticidade característica. Ainda que 
permanecer em inércia pode ser confortável, é preciso romper o casulo, abrir-se e rece-
ber o novo, e esta tarefa não é fácil. O aprimoramento intelectual vem acompanhado de 
uma constante incerteza (autocrítica) acerca do trabalho que se produz, seja ele qual for, 
e aqui encontrei possibilidades para este novo pensamento imagético.
	 Concluindo, esse exercício da imagem provou para mim que a melhor forma de 
se reinventar é visitando o passado, constato que observar o antigo é uma boa manei-
ra de se compreender o novo/presente, podendo-se encontrar este passado em obje-
tos, fotos, arquitetura, arte, vídeos, músicas, comportamentos, conversas e cultura, tudo 
aquilo que contenha, em si, a memória de algo/alguém, uma vez que com o tempo ela 
se perde na mente, mas se conserva nas coisas. Focando em meus registros imagéticos, 
encontrei a história de minhas origens, e somando estes à serigrafia, remontei a minha 
história com um novo espectro.
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“(..)em seu artigo sobre “A lembrança do 
presente”, Bergson, (...), admite que no 
momento em que percebemos um obje-
to podemos ter uma lembrança dele, do 
que resulta o fenômeno conhecido pelo 
nome de paramnésia. (..) evidentemente, 
a atualidade da lembrança não é definida 
pelo corpo, já que a representação que 
nasce da atitude corporal diante de um 
objeto chama-se percepção: a lembrança 
possui aqui uma consciência sui generis 
que lhe permite estar presente como 
lembrança, enquanto a percepção está 
presente como percepção.”

 (Sartre, A Imaginação, p. 50)

“Quando tudo aquilo começou, eles tomaram minha casa.
Perdi tudo que levei a vida inteira para construir.
Então decidi vir para a capital, trouxe todo mundo comigo”
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“Nesse dia eu toquei na banda da cidade, lembro da melodia até hoje. . . 
(solfeja ele com um sorriso nostálgico) .”
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“Que saudade, acho que um bicho tinha me picado nesse dia. . . 
nossa eu amo essa foto . . . “



20

“A gente já morava lá quando eles chegaram do interior, essa foto é da época 
que conheci sua mãe.”
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N U N C A M Á S

v e i n t i c u a t r o d e m a r z o
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	 O momento de conexão entre eu e a gravura surge do fato de que possuo uma 
impaciência em meu processo de produção. A gravura seria um meio para eu lidar com 
“o tempo da imagem”. Comecei pela xilogravura, em seguida a gravura em metal, po-
rém, ambas ainda que cheias de possibilidades, não instigavam o experimentalismo. Ca-
minhei pela litografia, mas sua alquimia me desencantou, sobrava-me então o linóleo e 
a serigrafia (dentre todas as formas de gravura ofertadas pela academia), e acontece que 
em serigrafia encontrei respostas rápidas e resultados mais próximos daquilo que eu pla-
nejava para com este trabalho. Coloquei-me então no lugar de pesquisador da técnica 
serigráfica, especificamente no processo de gravação da tela, processo esse que me fez 
chegar à policromia.
	 A policromia surge como solução estética para minha proposta de trabalho, por 
ser um facilitador na impressão de imagens fotográficas com mais de três cores e rique-
za detalhes, desde então venho pesquisado suas possibilidades. Para compreender a 
policromia é necessário ter em mente que, com o advento da imagem digital, no século 
passado, foi introduzido um novo conceito de impressão colorida, onde decompondo 
a imagem em retículas de  quatro cores (Ciano, Magenta, Yellow e blacK, que quando 
sobrepostas formam a imagem original), temos uma poli (mais de três) cromia (cores). A 
policromia em CMYK também existe sem retículas, imagens digitais possuem diversos 
formatos, entre eles o CMYK. Este formato é responsável por dividir a imagem em quatro 
camadas de cores; a retícula, que é uma espécie de pontilhismo, propõe uma geo loca-
lização dentro da área a ser impressa, onde a distancia e formato de cada ponto influem 
na formação da imagem. No geral, temos que para cada cor existe uma imagem formada 
de pequenos pontos, que se concentram (em áreas mais saturadas daquela respectiva 
cor) e se afastam (em áreas menos saturadas daquela respectiva cor),  e esses pontos, 
quando sobrepostos, formam a imagem. No percurso acadêmico, temos acesso a dois 
processos analógicos de policromia, off set e a policromia serigráfica, ambos usam a re-
tícula em quatro cores para a formação da imagem.
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	 O diferencial de produzir uma imagem impressa em policromia é o fato de que a 
sobreposição de todas as chapas de cor formam uma imagem em alta definição, desta 
forma é possível transcrever imagens com verossimelhança e precisão. 
	 A impressão off set moderna acontece por meio de uma máquina que imprime 
em CMYK, sobrepondo as chapas reticuladas, e temos então que 4 chapas distintas im-
primem uma imagem. A serigrafia policrômica manual, seria o “off set artesanal antes 
do off set artesanal”, onde as chapas de metal para off set são substituídas por telas 
emulsionadas. Além disso, o resultado da impressão é muito mais complexo, pois a se-
rigrafia é uma linguagem adepta do acaso, o processo de gravação e impressão (sem 
equipamento de precisão) sempre interferem no resultado final da impressão. Dessa 
forma, pode-se afirmar que a serigrafia em policromia não possui a mesma precisão (se 
impressa manualmente) da policromia em off set. A finalidade da impressão policrômica 
em maquinário off set é a sua maior precisão para impressos frente e verso encaderna-
dos como revistas, enquanto a policromia serigráfica agrega um valor mais plástico ao 
impresso. Seu caráter e peso de uma gravura transmitem as devidas complexidades do 
processo, colocando a policromia aqui em um lugar distinto, menos efêmero.
	 Pesquisar a policromia em serigrafia tem possibilitado uma busca constante por 
integrar o acaso à representação fidedigna da imagem, essa integração, dá margens 
para outras interpretações da mesma gravura (motivo que alimenta a pesquisa), por isso 
deixar que o acaso faça parte e interfira durante o processo de concepção da policromia, 
tem sido parte importante da pesquisa imagética.
	 Devido a sua complexidade, podemos pensar na policromia como uma espécie 
de equação diferencial, onde temos: id (imagem digital), CMYK (cores que podem ser 
medidas em valores/chapa), R (fotolitos reticuladas), i (impressão), T (tiragem) e ps (poli-
cromia serigráfica).

	 Equação: id é igual a CMYK (cores), dividos por 4 (chapas) vezes R (retícula) vezes 
4 i (impressões) dividias em T (variável de tiragem), com resultante igual a ps (policromia 
serigráfica).

	 Elaborando melhor o processo de gravação da tela, a arte dever ser feita em trans-
parência ou fotolito, pois este processo viabiliza uma precisão maior ao gravar a tela em 
30 segundos de exposição, (tempo varia de acordor com a fonte de luz UV utilizada, para 
minhas policromias a fonte possuia 400 Watts). Caso contrário, para menos tempo, os 
pontos estarão muito próximos, e para mais tempo, os pontos sumirão. A confecção do 
fotolito acontece através de meio digital, (photoshop CS5, no caso em questão). Com a 
imagem redimensionada para o tamanho de saída (impressão),  as guias de comando 
são:

Image>Mode>CMYKcolor.
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Definidas as cores, as guias de comando são:

Imagem>Imagesize>600dpi (para imagens menores que um A4);
Imagem>Imagesize>300dpi (para imagens menores que um A3);
Imagem>Imagesize>150 à 45dpi (para imagens em uma escala muito grande).

	 A resolução em dpi (Dots Per Inch ou Pontos por Polegada) aqui se refere à qua-
lidade/resolução da imagem dentro do tamanho/formato a ser impresso. Quanto maior 
a área de impressão da imagem, menos dpi se faz necessário, porque quanto maior a 
densidade dos pixels (dpi), maior será a quantidade de pontos, logo, uma impressão 
pequena precisa de mais pontos para formar a imagem e uma imagem muito grande 
precisa de menos pontos. Em seguida, as guias de comando são:

Filter>Pixelate>ColorandHalftone.

	 Aqui a imagem será reticulada em CMYK, já no formato final para impressão. Des-
sa forma, não há necessidade de alterar o formato e/ou densidade dos pontos na janela 
Color and Halftone. Em seguida, as guias de comando são:

Window>Channels.

	 No painel canal, estarão marcadas todas as layers de cor CMYK, excluidas três das 
quatro layers, deixando apenas uma (por exemplo Black e exclua as outras). Feito isso, as 
guias comando são:

Image>Mode>Grayscale.

	 Confirme todas as opções e a imagem irá se tornar preto e branco (esta imagem 
representa os pontos da cor Black). Salve o arquivo em formato .jpg, em alta resolução, 
e feito isso, retorne (ctr+alt+z) até o painel Channels estar com todas as cores, e repita 
este processo para cada cor. As imagens em.jpg devem ser impressas em transparência 
ou fotolito, em uma impressora a laser, preto.
	 Ao final teremos quatro fotolitos reticulados, cada um representando uma cor; es-
tes fotolitos impressos um sobre o outro, com tinta para policromia, formarão a imagem. 
A ordem de impressão das cores CMYK, uma vez que, a tinta utilizada interage e possui 
um caráter de mescla transparente quando sobreposta, pode-se inferir que, qualquer 
ordem é possível (porém, a imagem final terá resultados distintos). Na serigrafia artística 
opta-se muitas vezes por efeitos diferenciados; impressão sem tiragem (cópia única); 
velaturas na imagem (etc.), fugindo dos padrões pré-determinados pela indústria, onde 
a precisão é uma exigência de mercado. Pode-se então, imprimir cores em ordens troca-
das, por exemplo: imprimir a chapa C com a cor Y e a chapa Y com a cor C, o que resultará 
em uma inversão cromática na imagem final, em um total de dezesseis combinações 
possíveis.
	 Ao longo de todos os testes produzidos durante a pesquisa em ateliê, a ordem de 
impressão mais adequada é CMYK sobre papel branco modelo superwhite, resultando 
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em cores mais vivas e em um contraste maior, devido à adição de branco imposta pelo 
suporte.
	 Para a impressão de pequenos formatos, o rodo deve ser passado com uma incli-
nação maior que 45°, com pouca quantidade de tinta e rapidamente. Para pontos maio-
res e impressão em área maior, a inclinação de 45° é a mais indicada, a velocidade e a 
quantidade de tinta deve ser ponderada, mediante o formato da imagem. O resultado 
da mescla das cores e sobreposição dos pontos acontece minutos após a impressão, 
com a secagem total da tinta, sendo assim, a imediata interação das cores não é o re-
sultado final da impressão. O fotolito deve possuir um registro (em cruz, quadrado ou 
escala cromática, situados na margem de corte da imagem), que será impresso junto e 
próximo da imagem reticulada, servindo como guia para que cada cor seja impressa exa-
tamente, uma sobre a outra, já que qualquer descolamento interfere na formação final 
da imagem. Para a produção de minhas policromias, a guia proposta é um quadradinho, 
que ao final da impressão resulta nas quatro cores alinhadas horizontalmente, a impres-
são estará semelhante à imagem matriz.
	 Seguindo estas orientações, produzi diversas impressões entre provas e impres-
sões finais, e as que mais me atraíram foram as que possuíam erros de impressão, en-
tintagem com marcas da pressão do rodo etc. Esses erros atuam como veículos para 
a compreensão de como saturar ou dessaturar uma imagem manualmente, construir 
efeitos de tempo e desgaste, por fim, somar ruídos  de aspecto orgânico à imagem. Aqui, 
encontro uma direção para a releitura das fotografias que selecionei para retratar. Além 
de alguns processos de colagem e intervenção na composição da imagem digital, o pro-
cesso de impressão se fez valer como metiê para a construção de novas imagens, que, 
devido a estas interferências, intensificam no observador interpretações que fogem ao 
meu controle, como aconteceu em meu experimento familiar.

	 Assim como nas imagens impressas por uma polaroide, que podem sofrer inter-
ferências durante a revelação, minhas pequenas policromias sofreram interferências 
também durante a impressão, colocando-me nesse lugar do objeto que recebe, registra 
e imprime a imagem. Ainda que os significados e significantes que as memórias do pro-
cesso carregam persistam, de alguma forma, intactos dentro de mim.

“ Também a arte é apenas um modo de 
viver, e é possível se preparar para ela 
sem saber, vivendo de uma maneira ou 
de outra Em tudo o que é real há mais 
proximidade dela do que nas falsas profis-
sões semi-artisticas que, ao simular uma 
proximidade da arte, na prática negam e 
atacam a existência de qualquer arte.”

(Rilke, Cartas a um Jovem Poeta, p. 91)
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este livro não seria possível sem a ajuda de todos os	
envolvidos.
	 Deixo aqui, registrada, uma imensa gratidão a	
todos que tem colaborado de toda e qualquer maneira, 
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